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END-USER LICENSE AGREEMENT 
BY ACCEPTING, YOU (ORIGINAL PURCHASER) INDICATE YOUR ACCEPTANCE OF THESE TERMS. IF 
YOU DO NOT WISH TO ACCEPT THE PRODUCT UNDER THESE TERMS, YOU CAN CHOOSE NOT TO 
ACCEPT BY SELECTING "I decline..." AND NOT INSTALLING THE SOFTWARE. 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation (the Software) is Copyright © 
Acronis, Inc., 2000-2008. All rights are reserved. The ORIGINAL PURCHASER is granted a LICENSE to 
use the software only, subject to the following restrictions and limitations. 
1. The license is to the original purchaser only, and is not transferable without prior written 
permission from SonicWALL. 
2. The original purchaser can use the software on a single computer. You cannot use the 
software on more than a single machine, even if you own or lease all of them, without the written 
consent of SonicWALL. 
3. The original purchaser cannot engage in, nor permit third parties to engage in, any of the 
following: 
A. Providing or permitting use of by, or transferring the software to, third parties. 
B. Providing use of the software in a computer service business, network, timesharing or multiple 
user arrangement to users who are not individually licensed by SonicWALL. 
C. Making alterations or copies of any kind in the software (except as specifically permitted 
above). 
D. Attempting to unassemble, decompile or reverse-engineer the software in any way. 
E. Granting sublicenses, leases, or other rights in the software to others. 
F. Making copies, or verbal or media translations, of the users guide. 
G. Making telecommunication data transmission of the software. 
SonicWALL has the right to terminate this license if there is a violation of its terms or default by the 
original purchaser. Upon termination for any reason, all copies of the software must be immediately 
returned to SonicWALL, and the original purchaser shall be liable to SonicWALL for any and all 
damages suffered as a result of the violation or default. 
 
ENTIRE RISK 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU THE 
PURCHASER. SonicWALL DOES NOT WARRANT THAT THE SOFTWARE OR ITS FUNCTIONS WILL 
MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR FREE OR THAT ANY DEFECTS WILL BE CORRECTED.  
NO LIABILITY FOR CONSEQUENTIAL DAMAGES IN NO EVENT SHALL SonicWALL OR ITS VENDORS 
BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR 
THE LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 
OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE 
SOFTWARE, EVEN IF SonicWALL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
SOFTWARE USAGE TERMS AND CONDITIONS 
Under current legislation, the «License Agreement» is considered a contract between you and 
SonicWALL Inc. The contract is a legal document and its violation may result in legal action. 
Illegal use and/or distribution of this software will be prosecuted. 
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Chapter 1.  Introduction 
1.1 What is SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation? 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation solves all backup 
problems, ensuring the safety of all information on your PC. Using it, you can back up 
selected files and folders, Windows applications settings, settings and messages of Microsoft 
e-mail clients or entire disks and partitions.  

If failures occur that block access to information or affect system operation, or if you 
accidentally delete necessary files, you'll be able to easily restore the system and lost data.  

The unique technology implemented in SonicWALL Bare Metal Recovery and Local Archiving 
– Workstation allows you to create exact, sector-by-sector disk backups, including all 
operating systems, applications and configuration files, software updates, personal settings 
and data.  

You can store backups on almost any PC storage device: local hard drives, network drives or 
a variety of IDE, SCSI, FireWire (IEEE-1394), USB (1.0, 1.1 and 2.0) and PC Card (formerly 
called PCMCIA) removable media drives, as well as CD-R/RW, DVD-R/RW, DVD+R/RW, 
magneto-optical, Iomega Zip and Jaz drives.  

If you are going to install a new hard disk drive, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation will help you transfer information from the old one in minutes, 
including operating systems, applications, documents and personal settings.  

Wizards and a Windows XP-style interface will make your work easier. Just answer a few 
simple questions and let SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
take care of everything else! When a system problem occurs, the software will get you up 
and running in no time. 

Minimizes downtime 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation enables you to restore 
systems in minutes, not hours or days. An entire system can be restored from an image that 
includes everything the system needs to run: the operating system, applications, databases, 
and configurations. No reinstallation or reconfiguration is required.  

Eases Administration 
Wizards guide users through backup and recovery tasks, ensuring the product can be 
implemented with minimal user training. 

Supports Cutting Edge Technology  
Businesses today are moving to leverage the latest technologies, dual-core 64 bit processors 
and 64 bit operating systems.  With SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation, you can protect these new machines, as well as legacy ones, running one 
solution. 

1.2 New in SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation has the following new 
features: 
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Explore archives – easily search and recover particular files in archives just as in 
Windows Explorer 

Backup to DVD media 

One-click backup – launch the backup wizard by right-clicking on a disk and 
selecting Backup in the context menu.  

1.3 What is a disk image 
A disk (partition) image is a file that contains a copy of all information stored on a disk. 
Image stores all the server data including operating system, databases, all programs, data, 
and settings. 

By backing up your information regularly you will completely protect yourself from data 
losses in case of system failures and even server malfunctions. 

To restore your system after a failure it would be enough to restore information from a 
previously created image. 

By default SonicWALL Bare Metal Recovery and Local Archiving – Workstation image files 
have “.tib” extension and can contain images of several partitions or disks. 

An image file, containing a large partition image or several disks images, might have 
considerable size. In this case it can be split into several files that together make an original 
image. A single image can also be split for burning to removable media. 

 

SonicWALL Bare Metal Recovery and Local Archiving – Workstation stores only those hard 
disk parts that contain data (for supported partition types). This reduces image size and 
speeds up image creation and restoration. 

 

A partition image includes all files and folders independently of their attributes (including 
hidden and system files), boot record, FAT, and Root. 

 

A disk image includes images of all disk partitions as well as the zero track with Master Boot 
Record (MBR). 

1.4 System requirements and supported media 

1.4.1 Minimum system requirements 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation requires the following 
hardware: 

• Pentium processor or higher 

• 128 MB RAM 

• FDD or CD-RW drive for bootable media creation 

• Mouse (recommended). 

1.4.2 Supported operating systems 
• Windows® 2000 Professional SP 4 

• Windows® XP SP 2 

• Windows® XP Professional x64 Edition  
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• Windows® Vista 

SonicWALL Bare Metal Recovery and Local Archiving – Workstation also enables creating a 
bootable diskette or CD-R/W that can back-up and restore a disk/partition on a computer 
running any PC-based operating system including Linux®. 

1.4.3 Supported file systems 
• FAT16/32 

• NTFS 

• Ext2/Ext3 

• ReiserFS 

If a file system is not supported nor is corrupted, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation can copy data using a sector-by-sector approach. 

1.4.4 Supported storage media 
• Hard disk drives  

• Networked storage devices  

• CD-R/RW, DVD-R/RW, DVD+R (including double-layer DVD+R), DVD+RW, DVD-RAM* 

• USB 1.0 / 2.0, FireWire (IEEE-1394) and PC card storage devices 

• Floppy disks, ZIP®, Jaz® and other removable media  

* - Burned write-once discs cannot be read in Windows NT 4 without third-party software. 
Burned rewritable discs cannot be read in Linux without kernel patch.  

1.5 Software usage terms and conditions 
The conditions for SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
software usage are described in the «License Agreement» (page 3 of this manual). The 
unique registration number is a confirmation of your legal purchase and usage of SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation on your system. 

Under current legislation, the «License Agreement» is considered a contract between you 
and SonicWALL Inc. The contract is a legal document and its violation may result in legal 
action. 

Illegal use and/or distribution of this software will be prosecuted. 

1.6 Technical support 
Users of legally purchased copies of SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation are entitled to free e-mail technical support from SonicWALL. If you have 
installation or working problems that you can’t solve by yourself using this manual and the 
readme.txt file, e-mail the technical support team. 

When e-mailing technical support, you must provide the number of your SonicWALL Bare 
Metal Recovery and Local Archiving – Workstation copy bundled with the program. This 
number is made up of five sets of five characters separated by hyphens; there is a total of 
25 letters and numbers. 

For more information visit http://www.sonicwall.com/support/contact.html   
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Chapter 2.  SonicWALL Bare Metal Recovery 
and Local Archiving – Workstation 
installation and startup 
2.1 Installing SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation  
To install SonicWALL Bare Metal Recovery and Local Archiving – Workstation: 

• Run the SonicWALL Bare Metal Recovery and Local Archiving – Workstation setup file 

• In the Install Menu, select the program to install: SonicWALL Bare Metal Recovery and 
Local Archiving – Workstation 

• Follow the install wizard instructions on the screen.  

 

Typical, Custom and Complete installation is available. Having pressed Custom, you can 
choose to install Bart PE plug-in, besides SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation and SonicWALL Media Builder. 

The widely used Bart PE utility provides a Windows-like operating environment invoked via 
removable bootable media. Applications are installed into Bart PE in the form of plug-ins. 
Choosing Bart PE plug-in installation (disabled by default) provides the ability to include 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation into a Bart PE plug-in 
tab. The plug-in files will be placed into the component installation folder along with other 
program files. 

With SonicWALL Media Builder you can create bootable rescue disks (see details in 
Chapter 7. Creating Bootable Media). Installing the SonicWALL Media Builder will allow 
you to create bootable media or its ISO image at any time from the main program window or 
running SonicWALL Media Builder on its own. 

 

 

When installed, SonicWALL Bare Metal Recovery and Local Archiving – Workstation creates a 
new device in the Device Manager list (Control Panel -> System -> Hardware -> 
Device Manager -> SonicWALL Devices -> SonicWALL TrueImage Backup Archive 
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Explorer). Do not disable or uninstall this device, as it is necessary for connecting image 
archives as virtual disks (see Chapter 9. Exploring archives and mounting images). 

2.2 Extracting SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation  
When installing SonicWALL Bare Metal Recovery and Local Archiving – Workstation, you can 
save the setup (.msi) file on a local or network drive. This will help when modifying or 
recovering the existing component installation. 

To save a setup file: 

• Run the SonicWALL Bare Metal Recovery and Local Archiving – Workstation setup file; 

• In the Install Menu, right-click on the program name and select Extract; 

• Select a location for the setup file and click Save. 

2.3 Running SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation 
You can run SonicWALL Bare Metal Recovery and Local Archiving – Workstation in Windows 
by selecting Start -> Programs -> SonicWALL -> SonicWALL Bare Metal Recovery 
and Local Archiving – Workstation -> SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation or clicking on the appropriate shortcut on the desktop. 

If your disk data is totally corrupted and you cannot boot, load the standalone SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation version from the bootable media you 
created using SonicWALL Media Builder. Then you will be able to restore the disk from its 
previously created image. 

2.4 Upgrading SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation 
If you already have SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
installed, the new version will simply update it; there is no need to remove the old version 
and reinstall the software. 

Please keep in mind that the backups created by the later program version may be 
incompatible with the previous program versions. So, if you roll back SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation to the older version, most probably you will 
have to re-create the archives using the older version. For the same reason, we highly 
recommend that you create a new bootable media after each SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation upgrade. 

2.5 Removing SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation 
Select Start -> Settings -> Control panel -> Add or remove programs -> < 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation> -> Remove. 
Then follow instructions on the screen. You may have to reboot your computer afterwards to 
complete the task. 

 



 

Copyright © Acronis, Inc., 2000-2008                                                                                        11 

Chapter 3. General information 
3.1 Disk/partition images 
A backup archive is a file or a group of files (also called in this Guide “backups”), that 
contains a copy of all information stored on selected disks/partitions.  

Backing up disks and partitions is performed in a different way: SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation stores a sector-by-sector snapshot of the disk, 
which includes the operating system, registry, drivers, software applications and data files, 
as well as system areas hidden from the user. This procedure is called “creating a disk 
image,” and the resulting backup archive is often called a disk/partition image. 

 

SonicWALL Bare Metal Recovery and Local Archiving – Workstation stores only those hard 
disk parts that contain data (for supported file systems). Further, it does not back up swap 
file information (pagefile.sys under Windows NT/2000/XP) and hiberfil.sys (a file that keeps 
RAM contents when the computer goes into hibernation). This reduces image size and 
speeds up image creation and restoration. 

 

A partition image includes all files and folders independent of their attributes (including 
hidden and system files), boot record, FAT (file allocation table), root and the zero track of 
the hard disk with master boot record (MBR). 

 

A disk image includes images of all disk partitions as well as the zero track with master boot 
record (MBR). 

By default, files in all SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
archives have a “.tib” extension. 

It is important to note that you can restore files and folders from disk/partition images. To 
do so, mount the image as a virtual disk (see Chapter 9. Exploring archives and mounting 
images). 

 

Be careful! Disk letters in standalone SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation might sometimes differ from the way Windows identifies drives. For example, 
the D: drive identified in the standalone SonicWALL Bare Metal Recovery and Local Archiving 
– Workstation might correspond to the E: drive in Windows. 

3.2 Viewing disk and partition information 
You can change the way of data representation in all schemes you see in various wizards. 

To the right are three icons: Arrange Icons by, Choose Details and i (Display the 
properties of the selected item), the last duplicated in the context menu invoked by 
right-clicking objects. 

To sort messages by a particular column, click the header (another click will switch the 
messages to the opposite order) or Arrange Icons by button and select the column. 

To select columns to view, right-click the headers line or left-click the Choose Details 
button. Then flag the columns you want to display. 

If you click the i (Display the properties of the selected item) button, you will see the 
selected partition or disk properties window. 

This window contains two panels. The left panel contains the properties tree and the right 
describes the selected property in detail. The disk information includes its physical 
parameters (connection type, device type, size, etc.); partition information includes both 
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physical (sectors, location, etc.), and logical (file system, free space, assigned letter, etc.) 
parameters. 

You can change the width of a column by dragging its borders with the mouse. 

3.3 Backing up to tape drive 
The current version of SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
supports SCSI tape drives. It can store images on and restore them from tape, store large 
images to multiple tapes. 

If you have a SCSI tape drive connected to your server, the list of devices available for 
image storage and restoration will be extended with a name corresponding to the drive type. 

Images are created on and restored from tapes in the same way as from other devices, with 
the following exceptions. 

If you are to use data tapes previously used by other programs, their contents will be 
cleared. 

A new full image can be stored on an empty tape only. If you use tapes that already contain 
data, their contents will be cleared and overwritten. 

You don't have to provide a filename to store an image on or restore it from a tape. 

You might experience short pauses that are required to rewind the tape. 

 

Low-quality or old tape, as well as dirt on the magnetic head, might lead to pauses that can 
last up to several minutes long.  
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Chapter 4. Using SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation 
4.1 Main program window 
The main program window contains the menu, the toolbar, the sidebar, the Active Tasks 
pane and the main area. The main area contains operation icons, while the sidebar features 
Tools and Help panels.  

 
Main program window 

Most of the operations are represented two or even three times in different window areas, 
providing several ways to select them for more convenience. For example, you can start the 
necessary operation or tool by clicking its icon in the main area or by selecting the same 
item from the Operations or Tools menu. 

The main window contains operation icons divided into two groups. 

The Task group contains the following operations: 

• Backup – create a backup archive 

• Recovery – restore data from a previously created archive 

The Tools group contains the following items: 

• Explore and Validate Backup Archives – explore file-level archives, mount 
disk/partition images as virtual drives, run the archive integrity checking procedure 

• Create Bootable Rescue Media – run the bootable media creation procedure 

4.1.1 Program menu 
The program menu bar features the Operations, View, Tools and Help items. 

The Operations menu contains a list of the available operations. 

The View menu contains items for managing the program window look:  

• Toolbars – contains commands that control toolbar icons 
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• Common Task Bar – enables/disables the sidebar 

• Status Bar – enables/disables the status bar 

The Tools menu contains the following items: 

• Explore Backup Archives – runs the archive integrity checking procedure 

• Validate Backup Archive – run the archive integrity checking procedure 

• Create Bootable Rescue Media – run the bootable media creation procedure 

• Options – open a window for editing default backup/restore options, setting text 
appearance (fonts). 

The Help menu is used to invoke help and obtain information about SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation. 

4.1.2 Status bar 
At the bottom of the main window, there is a status bar divided into two parts. The left side 
briefly describes the selected operation; the right side indicates operation progress and 
results.  

4.1.3 Taskbar notification area icon 
During most of the operations, a special indicator icon appears in the Windows taskbar 
notification area (the right portion of the status bar with the clock). If you mouse over the 
icon, you will see a tool tip indicating the operation’s progress. This icon doesn’t depend on 
the main program window being open. It is present for background execution of scheduled 
tasks as well. 

4.2 Available operations 
You can perform the following operations on the computer. 

• Backup and restore data, including system disks/partitions 

Click Backup or Recovery, and then follow the Wizard’s instructions. See details in Chapter 
5. Creating backup archives and Chapter 6. Restoring a disk (partition). 

• Set up backup/restore options, such as backup process priority or compression level. 

Select Tools -> Options -> Default backup options or Default restoration options 
and make settings. See details in 5.2 Setting Backup Options and 6.3 Setting Restore 
Options. 

• Explore and validate backup archives wherever they reside, be it local, network or 
removable media 

Click Explore and Validate Backup Archive, and then follow the Wizard’s instructions. 
See details in 8.1 Validating backup archives and 9.1 Exploring an archive. 

• Mount partitions’ images to explore and modify their contents, or to restore individual 
files 

Click Mount image, then follow the Wizard’s instructions. See details in 9.2 Mounting an 
Image. 

• Unmount previously mounted partition images 

Click Unmount image, then follow the Wizard’s instructions. See details in 9.3 Unmounting 
an Image. 
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• Create bootable rescue media or its ISO image 

See Chapter 7. Creating Bootable Media. 
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Chapter 5. Creating backup archives 
To be able to restore the lost data or roll back your system to a predetermined state, you should 
first create a data or entire-system backup file. 

Backing up the entire system disk (creating a disk image) takes more disk space but enables you to 
restore the system in minutes in case of severe data damage or hardware failure. Moreover, the 
imaging procedure is much faster than copying files, and may significantly speed the backup 
process when it comes to backing up large volumes of data. 

5.1 The backup procedure 
Create a backup image of any set of your computer’s hard disks and partitions.  

Invoke the Create Backup Wizard by clicking on the backup operation icon in the main program 
window. 

5.1.1 Selecting disks/partitions to back up 
In the Partitions Selection window you will see the hard disk layout of your server. Flag a 
partition to select it. Flag a whole disk to select all its partitions. You can select one or more hard 
disks or any combination of partitions and hard disks. 

 
Disk and partition layout 

Having selected partitions and/or disks, click Next. Note that this button is disabled as far as no 
partitions or disks are selected. 

5.1.2 Selecting the backup destination 
Select the destination place for the backup on the hard disk, the network, CD-R/RW, DVD-
recordable, or removable media, such as FireWire (IEEE-1394) or USB (1.0, 1.1 and 2.0) device. 
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Backup archive location selection 

Select the image location in the disk tree. In the File name field, enter image file name.  

If there's already an image file with that name, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation will ask if you want to overwrite it. Overwriting the backup means that you 
discard the entire old archive and start creating a new one.  

 

You can store several partitions and/or disks images in a single file. 

 

The program can generate a unique filename. Just click Generate file name for a new file button 
at the right. 

Remember, the “farther” you store the archive from the original folders, the safer it will be in case 
of data damage. For example, saving the archive to another hard disk will protect your data if the 
primary disk is damaged. Data saved to a network disk or removable media will survive even if all 
your local hard disks are down.  

5.1.3 Selecting the backup options 
Select the backup options (that is, backup file splitting, compression level etc.). You may Use 
default options or Set the options manually. If the latter is the case, the settings will be 
applied only to the current backup task. Alternatively, you can edit the default options from the 
current screen. Then your settings will be saved as the defaults. See 5.2 Setting backup options for 
more information. 
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Choosing Backup Options 

5.1.4 Providing comments 
On the Archive Comments wizard page, you’ll be able to provide an archive file with comments 
about the server and its user, the hard disk, partition data, image creation time, and any 
peculiarities and conditions. 

 
Archive comments 
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The more details you provide in the comments, the better. If you don’t provide comments, you 
might mistake images and restore the wrong system partition, for example. 

However, you can choose not to make any notes. The backup file size and creation date are 
automatically appended to the description, so you do not need to enter this information. 

5.1.5 The operation summary and the backup process 
At the final step, the backup task summary is displayed. Up to this point, you can click Back to 
make changes in the created task. Clicking Proceed will launch the task execution.  

The task progress will be shown in a special window. You can stop the procedure by clicking 
Cancel.  

 
Backup creation script 

All operations of a partition (disk) image creation in an archive file are delayed in SonicWALL Bare 
Metal Recovery and Local Archiving – Workstation. A partition (disk) image creation script is 
created first; then it is executed. 

After you click Proceed, SonicWALL Bare Metal Recovery and Local Archiving – Workstation will 
start creating an image, indicating the progress in the special window. You can stop this procedure 
by clicking Cancel. 

You can also close the progress window by clicking Hide. The backup creation will continue, but 
you will be able to start another operation or close the main program window. In the latter case, 
the program will continue working in the background and will automatically close once the image is 
ready. If you prepare some more image creation operations, they'll be queued after the current 
one. 

 

If you burn the image to several removable media, be sure to number them, since you will have to 
insert them in order during the restoration. 
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5.2 Setting Backup Options 
To view or edit the default backup options, select Tools -> Options -> Default Backup 
Options from the main program menu.  

You can edit the default (or set the temporary) backup options while creating a backup task as 
well. 

 
Setting Backup Options 

5.2.1 Compression level 
The default setting – Normal. 

If you select None, the data will be copied without any compression, which may significantly 
increase the backup file size. However, if you select Maximum compression, the backup will take 
longer to create. 

The optimal data compression level depends on the type of files stored in the archive. For example, 
even maximum compression will not significantly reduce the archive size if the archive contains 
essentially compressed files, like .jpg, .pdf or .mp3. 

Generally, it is recommended that you use the default Normal compression level. You might want 
to select Maximum compression for removable media to reduce the number of blank disks 
required. 
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Setting Compression level 

5.2.2 Backup Priority 
The preset is Low. 

The priority of any process running in a system determines the amount of CPU usage and system 
resources allocated to that process. Decreasing the backup priority will free more resources for 
other CPU tasks. Increasing the backup priority may speed up the backup process due to taking 
resources from the other currently running processes. The effect will depend on total CPU usage 
and other factors. 

 
Setting Backup Priority 

5.2.3 Archive-splitting 
Sizeable backups can be split into several files that together make the original backup. A backup 
file can be split for burning to removable media. 
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The preset is Automatic. With this setting, SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation will act as follows.  

When backing up to the hard disk: If the selected disk has enough space and its file system allows 
the estimated file size, the program will create a single archive file.  

If the storage disk has enough space, but its file system does not allow the estimated file size, 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation will automatically split the 
backup into several files. 

 

FAT16 and FAT32 file systems have a 4 GB file size limit. At the same time, the existing 
hard drive’s capacity may reach as much as 2 TB. Therefore, an archive file might easily 
exceed this limit, if you are going to back up the entire disk. 

If you do not have enough space to store the image on your hard disk, the program will warn you 
and wait for your decision as to how you plan to fix the problem. You can try to free some 
additional space and continue or click Back and select another disk.  

When backing up to a diskette, CD-R/RW or DVD+R/RW: SonicWALL Bare Metal Recovery and 
Local Archiving – Workstation will ask you to insert a new disk when the previous one is full. 

Alternatively, you can select Fixed size and enter the desired file size or select it from the drop-
down list. The backup will then be split into multiple files of the specified size. That comes in handy 
when backing up to a hard disk with a view to burning the archive to CD-R/RW or DVD+R/RW later 
on. 

 

Creating images directly on CD-R/RW or DVD+R/RW might take considerably more time 
than it would on a hard disk. 

 
Setting Archive Splitting 

5.2.4 Media Components 
The preset is disabled. 
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When backing up to removable media, you can make this media bootable by writing to it additional 
components. Thus, you will not need a separate rescue disk. 

Choose the basic components, necessary for boot and restoring data, on the General tab. 

The SonicWALL One-Click Restore is a minimal addition to your rescue media, allowing one-
click disk recovery from an image archive, stored on this media. This means that at boot from the 
media and clicking “restore” all the data contained in the image will be silently restored.  

 
Because one-click approach does not imply user selections, like selecting partitions to 
restore, SonicWALL One-Click Restore always restores the entire disk. Therefore, if your 
disk consists of several partitions and you are planning to use SonicWALL One-Click 
Restore, all the partitions must be included into the image. Any partitions which are 
missing from the image will be lost. 

If you want more functionality during restoration, write a standalone version of SonicWALL Bare 
Metal Recovery and Local Archiving – Workstation to the rescue disk.  

Under Advanced tab you can select full, safe or both SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation loader version. The safe version does not have USB, PC card or SCSI 
drivers and is useful only in case the full version does not load. If you have other SonicWALL 
products, such as SonicWALL Disk Director Suite, installed on your computer, the bootable versions 
of these programs’ components will be offered as Advanced as well. 

 

Setting Media Components 

5.2.5 Additional Settings 
Validate backup archive upon operation completion 

The preset is disabled. 

You can choose to check the backup data integrity. Verification will be performed immediately after 
the archive is created. 

Ask for first media while creating backup archives on removable media  

The preset is enabled.  
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You can choose whether to display the Insert First Media prompt when backing up to removable 
media. With the default setting, backing up to removable media may be not possible if the user is 
away, because the program will wait for someone to press OK in the prompt box. Therefore, you 
should disable the prompt when scheduling a backup to removable media. Then, if the removable 
media is available (for example, CD-R/RW inserted) the task can run unattended. 
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Chapter 6. Restoring a disk (partition) 
6.1 Restore under Windows or boot from CD? 
As mentioned above (see 2.3 Running SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation), SonicWALL Bare Metal Recovery and Local Archiving – Workstation can be run 
in several ways. However, disk restoration is always performed just one way. 

We recommend that you first try to restore data running SonicWALL Bare Metal Recovery 
and Local Archiving – Workstation under Windows, because this method provides more 
functionality. Boot from the bootable media only if Windows does not load. 

The boot disk (e.g. a CD) from which you loaded the program does not keep you from using 
other CDs with images. SonicWALL Bare Metal Recovery and Local Archiving – Workstation is 
loaded entirely into RAM, so you can remove the bootable CD to insert an image disk. 

To restore a partition (disk) from an image, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation must obtain exclusive access to this partition (disk). This means 
no other applications can access it at that time. If you receive a message stating that the 
partition (disk) can not be blocked, close applications that use this partition (disk) and start 
over. If you can not determine which applications use the partition (disk), close them all. 

 

Be careful! Disk letters in standalone SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation might sometimes differ from the way Windows identifies drives.  For example, 
the D: drive identified in the standalone SonicWALL Bare Metal Recovery and Local Archiving 
– Workstation might correspond to the E: drive in Windows. 

6.2 Restoring disks/partitions or files from images 
To restore a partition (disk) from an image, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation must obtain exclusive access to the target partition (disk). This 
means no other applications can access it at that time. If you receive a message stating that 
the partition (disk) can not be blocked, close applications that use this partition (disk) and 
start over. If you cannot determine which applications use the partition (disk), close them all.  

6.2.1 Starting the Restore Data Wizard 
Invoke the Restore Data Wizard by clicking on the Recovery operation icon in the main 
program window. Click Next. 

6.2.2 Archive selection 
Find and select the file, containing an image of the required partition. If the image is stored 
on removable media, connect this media, or insert the image CD/DVD (if the image was 
splitted to several CDs/DVDs, insert the last one). The File Name field will reflect its name 
and the Next will become available.  

If you added a comment to the archive, it will be displayed to the right of the drives tree. 
The comment is displayed in the right part of the window.  

 

If the archive is located on removable media, e.g. CD, first insert the last CD and 
then insert disks in reverse order when Restore Data Wizard prompts. 
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Archive selection for restoration 

6.2.3 Selecting a disk/partition to restore 
The selected archive file can contain images of several partitions or even disks. Select which 
disk/partition to restore. 

 
Disks and partitions images contain a copy of track 0 along with MBR (Master Boot Record). 
It appears in this window in a separate line. You can choose whether to restore MBR and 
track 0 by checking the respective box. Restore MBR if it is critical to your system boot. 

6.2.4 Selecting a target disk/partition 
Select a target disk or partition where you want to restore the selected image. You can 
restore data to their initial location, to another disk/partition or to an unallocated space. The 
target partition should be at least the same size as the uncompressed image data. 
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All the data stored on the restored partition will be replaced by the image data, so 
be careful and watch for non-backed-up data that you might need. 

When restoring an entire disk, the program will analyze the target disk structure to see if the 
disk is free.  

 
Selecting a target disk/partition 

6.2.5 Changing the restored partition type 
When restoring a partition, you can change its type, though it is not required in most cases.  

To illustrate why you might need to do this, let’s imagine that both the operating system and 
data were stored on the same primary partition on a damaged disk.  

If you are restoring a system partition to the new (or the same) disk and want to load an 
operating system from it, you will select Active. 

If you restore a system partition to another hard disk with its own partitions and OS, most 
probably you will need only the data. In this case, you can restore the partition as Logical 
to access the data only.  

By default, the original partition type is selected. 

 

Selecting Active for a partition without an installed operating system 
could prevent your server from booting. 
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Selecting a restored partition type 

6.2.6 Changing the restored partition file system 
Though seldom required, you can change the partition file system during its restoration. 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation can make the following 
file system conversions: FAT 16 -> FAT 32, Ext2 -> Ext3. For partitions with other native 
file systems this option is not available. 

 

Let us imagine you are to restore a partition from an old, low-capacity FAT16 disk to a 
newer disk. FAT16 would not be effective and might even be impossible to set on the high-
capacity hard disk. That's because FAT16 supports partitions up to 4 GB, so you will not be 
able to restore a 4 GB FAT16 partition to a partition that exceeds that limit without changing 
the file system. It would make sense here to change the file system from FAT16 to FAT32. 
However, keep in mind that not all operating systems support FAT32. MS-DOS, Windows 95 
and Windows NT 3.x, 4.x do not support FAT32 and will not be operable after you restore a 
partition and change its file system. These can be normally restored on a FAT16 partition 
only. 

6.2.7 Changing the restored partition size and location 
You can resize and relocate a partition by dragging it or its borders with a mouse or by 
entering corresponding values into the appropriate fields. 

Using this feature, you can redistribute the disk space between partitions being restored. In 
this case, you will have to restore the partition to be reduced first. 
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Changing the restored partition size 

6.2.8 Assigning a letter to the restored partition 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation will assign an unused 
letter to a restored partition. You can select the desired letter from a drop-down list. If you 
set the switch to No, no letters will be assigned to the restored partition, hiding it from OS. 

You should not assign letters to partitions inaccessible to Windows, such as to those other 
than FAT and NTFS. 

 
Assigning a letter to the restored partition 
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6.2.9 Restoring several disks or partitions at once 
During a single session, you can restore several partitions or disks, one by one, by selecting 
one disk and setting its parameters first and then repeating these actions for every partition 
or disk to be restored. 

If you want to restore another disk (partition), select Yes, I want to restore another 
partition or hard disk drive. Then you will return to the partition selection window (6.2.3) 
again and will have to repeat the above steps. Otherwise, don’t set this switch. 

 
Restoring several disks or partitions at once 

6.2.10 Setting restore options 
Select the options for the restoration process (that is, pre/post restoration commands, 
restoration process priority etc.). You may Use default options or Set the options 
manually. If the latter is the case, the settings will be applied only to the current restore 
task. Alternatively, you can edit the default options from the current screen. Then your 
settings will be saved as default. See 6.3 Setting Restore Options for more information. 
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Choosing restore options 

6.2.11 Restoration summary and executing restoration 
At the final step, the restoration summary is displayed. Up to this point, you can click Back 
to make changes in the created task. If you click Cancel, no changes will be made to 
disk(s). Clicking Proceed will launch the task execution.  

The task will appear on the Active tasks pane of the main window. The task progress will 
be shown in a special window.  

You can stop the procedure by clicking Cancel. However, it is critical to note that the target 
partition will be deleted and its space unallocated – the same result you will get if the 
restoration is unsuccessful. To recover the “lost” partition, you will have to restore it from 
the image again. 
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6.3 Setting restore options 
To view or edit the default restore options, select Tools -> Options -> Default 
Restoration Options from the main program menu.  

You can edit the default (or set the temporary) restore options while creating a restore task 
as well. 

 

6.3.1  Restoration priority 
The preset is Low. 

The priority of any process running in a system determines the amount of CPU usage and 
system resources allocated to that process. Decreasing the restoration priority will free more 
resources for other CPU tasks. Increasing of restoration priority may speed up the restore 
process due to taking resources from the other currently running processes. The effect will 
depend on total CPU usage and other factors. 

 

Setting restoration priority 
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6.3.2  Additional settings 
1. Before data is restored from the archive, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation can check its integrity. If you suspect that the archive might have 
been corrupted, select Validate backup archive before restoration. 

2. Having restored a disk/partition from an image, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation can check the integrity of the file system. To do so, select Check 
file system after restoration. 

 

Verification of the file system is available only when restoring disk/partitions under Windows 
2000/XP and for FAT16/32 and NTFS file systems. 
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Chapter 7. Creating Bootable Media 
7.1 Creating SonicWALL rescue media 
 

You can run SonicWALL Bare Metal Recovery and Local Archiving – Workstation on a crashed 
computer that cannot boot. You can even back up disks on a non-Windows computer, 
copying all its data sector-by-sector into the backup archive. To do so, you will need 
bootable media with the standalone SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation version. 

If you purchased SonicWALL Bare Metal Recovery and Local Archiving – Workstation on the 
Web, you can create bootable media using the SonicWALL Media Builder. For this, you will 
need a blank CD-R/RW or several formatted diskettes (the wizard will tell you the exact 
number), or any other media your computer can boot from, such as a Zip drive.  

SonicWALL Bare Metal Recovery and Local Archiving – Workstation also provides the ability 
to create an ISO image of a bootable disk on the hard disk.  

 

If you have chosen not to install the SonicWALL Media Builder during SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation installation, you will not be 
able to use this feature. 

1. Click Create Bootable Rescue Media on the toolbar or the sidebar, or select Create 
Bootable Rescue Media from the Tools menu. You can also run the SonicWALL Media 
Builder without loading SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
by selecting Programs -> SonicWALL -> SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation -> Bootable Rescue Media Builder from the Start menu. 

2. Select which components of SonicWALL programs you want to place on the bootable 
media.  

 
Rescue Media Contents Selection 

SonicWALL Bare Metal Recovery and Local Archiving – Workstation offers the following 
components: 
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• SonicWALL Bare Metal Recovery and Local Archiving – Workstation full 
version 

Includes support of USB, PC Card and SCSI interfaces along with the storage devices 
connected via them, and therefore is highly recommended. 

• SonicWALL Bare Metal Recovery and Local Archiving – Workstation safe 
version 

Does not include USB, PC Card, or SCSI drivers. Recommended for use in case of problems 
with running Full version. 

3. Select the type of bootable media (CD-R/RW or 3.5” diskettes) to create. If your BIOS has 
this feature, you can create other bootable media such as removable USB flash drives. You 
can also choose to create a bootable disk ISO image or save bootable data on the RIS 
server. 

 

When using 3.5” diskettes, you will be able to write on a diskette (or a set 
of the diskettes) only one component at a time (for example, SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation). To write another 
component, start Bootable Media Builder once again. 

 

Bootable Media Selection 

4. If you are creating a CD, diskettes or any removable media, insert the blank disk so the 
program can determine its capacity. If you choose to create a bootable disk ISO image, 
specify the ISO file name and the folder in which to place it.  

5. Next, the program will calculate how many blank disks are required (in case you have not 
chosen ISO) and give you time to prepare them. When you are finished, click Proceed. 

After you create a boot disk, identify it and keep it in a safe place. 

Please keep in mind that the backups created by the later program version may be 
incompatible with the previous program versions. By this reason, we highly recommend that 
you create a new bootable media after each SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation upgrade.  
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7.2 Creating a Win PE ISO with SonicWALL Bare Metal Recovery and 
Local Archiving – Workstation 
Windows Preinstallation Environment (Win PE) is a minimal Windows system based on the 
Windows XP Professional and the Windows Server 2003 kernels. Win PE is commonly used 
by OEMs and corporations for deployment, test, diagnostic and system repair purposes. 
Using SonicWALL Bare Metal Recovery and Local Archiving – Workstation in Windows 
Preinstallation Environment allows a combination of SonicWALL Bare Metal Recovery and 
Local Archiving – Workstation and Win PE facilities and provides more functionality than 
using only bootable media. 

To add the SonicWALL Bare Metal Recovery and Local Archiving – Workstation plug-in to 
your Win PE distribution: 

1. Make sure that Bart PE plug-in is installed on the computer (the default path is 
\Program Files\SonicWALL\SonicWALLBareMetalRecoveryandLocalArchiving\BartPE). If not, 
run SonicWALL Bare Metal Recovery and Local Archiving – Workstation setup file, choose 
Modify and install the Bart PE plug-in. 

SonicWALL Win PE ISO Builder locates the SonicWALL Bart PE plug-in using the registry key 
HKEY_LOCAL_MACHINE\SOFTWARE\SonicWALL\ 
SonicWALLBareMetalRecoveryandLocalArchiving\Settings\BartPE, created at the 
time of installation. If you moved the Bart PE plug-in to another folder after installation, 
change the key accordingly. If the above key is missing, the builder does not work. 

2. Insert your Win PE distribution CD into the media drive of the computer. If you have a 
distribution copy on the hard disk, copy the path to it. The distribution files must be 
unpacked and allocated in a separate folder. 

3. Select Programs -> SonicWALL ->SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation -> SonicWALL Win PE ISO Builder. 

4. Specify a source folder for building Win PE ISO, i.e. the media drive with Win PE 
distribution or a folder with the distribution copy. 

5. Locate a folder where you want to create Win PE ISO and provide the name for the ISO 
file. 

6. Check your settings in the summary screen and click Proceed. 

7. Use any third-party tool that will burn ISO images to CD or DVD. 

 

Media based on Win PE 2.0 and including SonicWALL Bare Metal Recovery and 
Local Archiving – Workstation requires at least 768MB RAM to work. 
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Chapter 8. Other operations 
8.1 Validating backup archives 
To be certain that your archives are not damaged, you can check their integrity. 

1. To invoke the Backup Archive Validation Wizard, select Validate Backup Archive in 
the main window or in the Tools group or click Validate Backup Archive on the toolbar. 

2. Click Next. 

3. Select the archive to validate.  

 
Selecting archive to validate 

4. Click Next. 

5. Clicking Proceed will launch the validation procedure. After the validation is complete, 
you will see the results window. You can cancel checking by clicking Cancel. 
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Chapter 9. Exploring archives and mounting 
images 
SonicWALL Bare Metal Recovery and Local Archiving – Workstation offers two kinds of 
archive contents management: mounting and exploring for images. Both operations are 
performed via the Backup Archives category. 

Exploring images lets you view their contents and copy the selected files to the hard disk. 

Mounting images as virtual drives lets you access them as though they were physical 
drives. This means that: 

• a new disk with its own letter will appear in the drives list 

• using Windows Explorer and other file managers, you can view the image contents as if 
they were located on a physical disk or partition 

• SonicWALL Bare Metal Recovery and Local Archiving – Workstation mounts the image 
only in read-only mode. 

The following is a brief summary of the Explore vs Mount operation: 

    Explore    Mount 

Archive type   Disk or partition image  Partition image 

Assigning a letter  No     Yes 

Archive modification   No     No 

Files extraction   Yes     Yes 

 

The current version of SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation can mount or explore an image archive only if all its volumes reside in 
the same directory. If your archive spans several CD-R/RW discs and you wish to 
mount the image, you should copy all volumes to a hard disk drive or network 
drive. 

9.1 Exploring an archive 
1. Click Explore and Validate Backup Archives in the Tools group or select the Backup 
Archives category on the sidebar to navigate to the Manage Backup Archives window. Then 
select Explore Backup Archive. Or, you can select Tools -> Explore Backup Archive in 
the main program menu.  

2. Select an archive from the drive tree and click Open.  
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If you added a comment to the archive, it will be displayed to the right of the drives tree. If 
the archive was protected with a password, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation will ask for it. Further steps will not be enabled until you enter the 
correct password. 

3. The program opens a Windows Explorer window displaying the archive contents.  

Double-click the slice icon to view the data saved in the backup. You can copy any file or 
folder from the backup being explored and paste it to any hard disk folder. 

9.2 Mounting an image 
1. Invoke the Mount Image Wizard by clicking on the Mount Image operation icon in 
the main program window. 

2. Click Next. 

3. Select the archive from the drives tree.  
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Selecting an image to mount 

If you added a comment to the archive, it will be displayed to the right of the drives tree. If 
the archive was protected with a password, SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation will ask for it. Neither the partitions layout, nor the Next button will 
be enabled until you enter the correct password.  

4. Click Next. 

5. Select a partition to mount as a virtual disk. (Note that you cannot mount the entire disk.)  

You can also select a letter to be assigned to the virtual disk from the Drive letter drop-
down list. If you do not want to assign a letter to the virtual drive, select Do not assign.  

 
6. Click Next. 
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7. The program displays a summary containing a single operation. Click Proceed to connect 
the selected partition image as a virtual disk. 

8. After the image is connected, the program will run Windows Explorer, showing its 
contents. Now you can operate with files or folders as if they were located on a real disk. 

You can connect multiple partition images. If you want to connect another partition image, 
repeat the procedure.  

9.3 Unmounting an image 
We recommend that you unmount the virtual disk after all necessary operations are finished, 
as keeping up virtual disks takes considerable system resources. If you do not, the virtual 
disk will disappear after your server is turned off. 

To disconnect the virtual disk, click Unmount Image and select the disk to unmount. You 
can also unmount the disk in Windows Explorer by right-clicking on its icon and selecting 
Unmount. 
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Chapter 10. Troubleshooting 
10.1 Recovering SonicWALL Bare Metal Recovery and Local Archiving – 

Workstation 
If SonicWALL Bare Metal Recovery and Local Archiving – Workstation ceases running or 
produces errors, its files might be corrupted. To fix it, you will have to recover the program. 
To do this, run SonicWALL Bare Metal Recovery and Local Archiving – Workstation installer 
again. It will detect SonicWALL Bare Metal Recovery and Local Archiving – Workstation on 
your server and will ask you if you want to recover (update) or remove it. 

Click Recover and click Proceed. 

10.2 Frequently asked questions 
What storage devices does SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation support for keeping backups? 

Backups can be created on both hard disks, and other storage devices supported by 
Windows 2000, XP, Vista. 

What is the purpose of specifying image file size? 

The server hard disk is the fastest and most effective storage device. It can write a 
disk (partition) image considerably faster than any other device, such as a CD-R/RW 
or DVD+R/RW. Having specified image volume size (for example, 600–650Mb for 
CD-R/RW), you can quickly create image files on your hard disk that you can burn 
to appropriate media afterwards. This allows you to do the entire task much more 
quickly. 

What devices can a system partition be restored from, if SonicWALL Bare Metal 
Recovery and Local Archiving – Workstation is loaded from its bootable diskette 
of CD? 

SonicWALL Bare Metal Recovery and Local Archiving – Workstation supports any 
connected hard disks, network locations as well as CD-R/RW, DVD+R/RW, DVD-RW 
and a wide variety of FireWire (IEEE-1394) and USB (1.0, 1.1, 2.0) devices. 

Can Easy CD Creator 4.x–5.0 impede SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation ? 

Easy CD Creator 4.x and 5.0 automatically installs an old version of Take Two® 
backup utility that is no longer supported by its manufacturer, Roxio. If SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation detects this utility, it shows 
you the following message in the beginning of image creation: 

"Can’t create the image of the logical disk, as it’s already used by a running 
application. Please close all other applications and try again." 

We recommend that you update your Easy CD Creator to Version 5.1 or newer 
and/or completely remove Take Two®. 

For more information, visit 
http://www.roxio.com/en/support/roxio_support/taketwo.html 

I created an image on CD-R/RW disks, but when I try to browse it, SonicWALL 
Bare Metal Recovery and Local Archiving – Workstation tells me it can’t connect 
this image as a virtual disk. 
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The current version of SonicWALL Bare Metal Recovery and Local Archiving – 
Workstation can connect images only if their files are located in the same place. If 
your image is located on several CD-R/RW or hard disks, you will have to copy all its 
files to a single folder on your hard disk. 

I received the "Can’t create image of disk D:, because it’s already used by 
applications or contains bad sectors" error message, where D: stands for my 
logical disk, when I tried to create an image under Windows. 

Your logical disk might contain bad sectors. We recommend you to run a complete 
disk surface test. Type “chkdsk /R D:” in the command line and reboot if needed. 



 

44                                                                                        Copyright © Acronis, Inc., 2000-2008 

Appendix A. Partitions and file systems 
A.1 Hard disk partitions 

The mechanism that allows you to install several operating systems on a single PC 
or to carve up a single physical disk drive into multiple “logical” disk drives is called 
partitioning. 

Partitioning is performed by special applications. In MS-DOS and Windows, these 
are FDISK and Disk Administrator.  

Partitioning programs perform the following: 

• create a primary partition 
• create an extended partition that can be split into several logical disks 
• set an active partition (applied to a single primary partition only) 

 

Information about partitions on a hard disk is stored in a special disk area – in the 1st sector 
of cylinder 0, header 0, which is called the partition table. This sector is called the master 
boot record, or MBR. 

 

A physical hard disk might contain up to four partitions. This limit is forced by the partition 
table that is suitable for four strings only. However, this does not mean you can have only 
four operating systems on your PC! Applications called disk managers support far more 
operating systems on disks. For example, SonicWALL OS Selector, a component of Acronis 
Disk Director Suite, enables you to install up to 100 operating systems! 

A.2 File systems 
An operating system gives the user the ability to work with data by supporting some 
type of file system on a partition. 

All file systems are made of structures that are necessary to store and manage 
data. These structures are usually composed of operating system boot sectors, 
folders and files. File systems perform the following basic functions: 

• track occupied and free disk space (and bad sectors, if any) 
• support folders and file names  
• track physical location of files on disks 

Different operating systems use different file systems. Some operating systems are 
able to work with only one file system while others can use several of them. Here 
are some of the most widely used file systems: 

A.2.1 FAT16 

The FAT16 file system is widely used by DOS (DR-DOS, MS-DOS, PC-DOS, PTS-DOS 
and other), Windows 98/Me, and Windows NT/2000/XP operating systems and is 
supported by most other systems. 

Main features of FAT16 are the file allocation table (FAT) and clusters. FAT is the 
core of the file system. To increase data safety, it is possible to have several copies 
of the FAT (there are usually two of them) on a single disk. A cluster is a minimum 
data storage unit in FAT16 file system. One cluster contains a fixed number of 
sectors. FAT stores information about what clusters are free, what clusters are bad, 
and also defines in which clusters files are stored. 
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The FAT16 file system has a 2GB limit that permits a maximum 65,507 clusters that 
are 32Kb in size. (Windows NT/2000/XP support partitions up to 4GB with up to 
64Kb clusters). Usually the smallest cluster size is used to make the total cluster 
amount within the 65,507 range. The larger a partition is, the larger its clusters are. 

 

Usually the larger the cluster size, the more disk space is wasted. A single byte of data 
could use up one cluster, whether the cluster size is 32Kb or 64Kb. 

Like many other file systems, the FAT16 file system has a root folder. Unlike others, 
however, its root folder is stored in a special place and is limited in size (standard 
formatting produces a 512-item root folder). 

Initially, FAT16 had limitations on file names. They could only be eight characters 
long, plus a dot, plus three characters of name extension. However, long-name 
support in Windows 95 and Windows NT bypasses this limitation. The OS/2 
operating system also supports long names, but does so in a different way. 

A.2.2 FAT32 

The FAT32 file system was introduced in Windows 95 OSR2. It is also supported by 
Windows 98/Me/2000/XP. FAT32 is an evolved version of FAT16. Its main 
differences from FAT16 are 28-bit cluster numbers and a more flexible root, whose 
size is unlimited. The reasons FAT32 appeared are the support of large hard disks 
(over 8GB in capacity) and the impossibility to implement any more complex file 
system into MS-DOS, which is still the base for Windows 98/Me. 

The maximum FAT32 disk size is 2 terabytes (1 terabyte, or TB, is equal to 1024 
gigabytes, or GB). 

A.2.3 NTFS 

NTFS is the main file system for Windows NT/2000/XP. Its structure is closed, so no 
other operating system is fully supported. The main structure of NTFS is the MFT 
(master file table). NTFS stores a copy of the critical part of the MFT to reduce the 
possibility of data damage and loss. All other NTFS data structures are special files. 
NTFS stands for NT File System. 

Like FAT, NTFS uses clusters to store files, but cluster size does not depend on 
partition size. NTFS is a 64-bit file system. It uses unicode to store file names. It is 
also a journaling (failure-protected) file system, and supports compression and 
encryption. 

Files in folders are indexed to speed up file search. 

A.2.4 Linux Ext2 

Ext2 is one of the main file systems for the Linux operating system. Ext2 is a 32-bit 
system. Its maximum size is 16TB. The main data structure that describes a file is 
an i–node. A place to store the table of all i-nodes has to be allocated in advance 
(during formatting). 

A.2.5 Linux Ext3 

Officially introduced with its version 7.2 of the Linux operating system, Ext3 is the 
Red Hat Linux journaling file system. It is forward and backward compatible with 
Linux ext2. It has multiple journaling modes and broad cross-platform compatibility 
in both 32- and 64-bit architectures. 
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A.2.6 Linux ReiserFS 

ReiserFS was officially introduced to Linux in 2001. ReiserFS overcomes many Ext2 
disadvantages. It is a 64-bit journaling file system that dynamically allocates space 
for data substructures. 
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Appendix B.  Hard disks and BIOS setup 
The appendices below provide you with extra information on the hard disk 
organization, how information is stored on disks, how disks should be installed in 
the computer and plugged into the motherboard, configuring disks with BIOS, 
partitions and file systems, and how operating systems interact with disks. 

B.1 Installing hard disks in computers 

B.1.1 Installing a hard disk, general scheme 
To install a new IDE hard disk, you should do the following (we will assume you 
have powered OFF your PC before you start!): 

1. Configure the new hard disk as slave by properly installing jumpers on the 
board of its controller. Disk drives generally have a picture on the drive that 
shows the correct jumper settings. 

2. Open your computer and insert the new hard disk into a 3.5’’ or 5.25’’ slot with 
special holders. Fasten down the disk with screws. 

3. Plug the power cable into the hard disk (four-threaded: two black, yellow and 
red; there is only one way you can plug in this cable). 

4. Plug the 40- or 80-thread flat data cable into sockets on the hard disk and on 
the motherboard (plugging rules are described below). The disk drive will have 
a designation on the connector or next to it that identifies Pin 1. The cable will 
have one red wire on an end that is designated for Pin 1. Make sure that you 
place the cable in the connector correctly. Many cables also are “keyed” so that 
they can only go in one way. 

5. Turn your computer on and enter BIOS setup by pressing the keys that are 
displayed on the screen while the computer is booting. 

6. Configure the installed hard disk by setting the parameters type, cylinder, heads, 
sectors and mode (or translation mode; these parameters are written on the 
hard disk case) or by using the IDE autodetection BIOS utility to configure the 
disk automatically. 

7. Set the boot sequence to A:, C:, CD-ROM or some other, depending on where 
your copy of SonicWALL Bare Metal Recovery and Local Archiving – Workstation 
is located. If you have a boot diskette, set the diskette to be first; if it is on a 
CD, make the boot sequence start with CD-ROM. 

8. Quit BIOS setup and save changes. SonicWALL Bare Metal Recovery and Local 
Archiving – Workstation will automatically start after reboot. 

9. Use SonicWALL Bare Metal Recovery and Local Archiving – Workstation to 
configure hard disks by answering the wizard’s questions. 

10. After finishing the work, turn off the computer, set the jumper on the disk to 
the master position if you want to make the disk bootable (or leave it in slave 
position if the disk is installed as additional data storage). 

B.1.2 Motherboard sockets, IDE cable, power cable 
There are two slots on the motherboard to which the hard disks can be connected: 
primary IDE and secondary IDE. 
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Hard disks with an IDE (Integrated Drive Electronics) interface are connected to the 
motherboard via a 40- or 80-thread flat marked cable: one of the threads of the 
cable is red. 

Two IDE hard disks can be connected to each of the sockets, i.e. there can be up to 
four hard disks of this type installed in the PC. (There are three plugs on each IDE 
cable: two for hard disks and one for the motherboard socket.) 

As noted, IDE cable plugs are usually designed so that there is only one way to 
connect them to the sockets. Usually, one of the pinholes is filled on the cable plug, 
and one of the pins facing the filled hole is removed from the motherboard socket, 
so it becomes not possible to plug the cable in the wrong way. 

In other cases, there is a jut on the plug on the cable, and an indentation in the 
socket of the hard disk and of the motherboard. This also ensures that there only 
one way to connect the hard disk and the motherboard. 

In the past, this design of plug did not exist, so there was an empirical rule: the 
IDE cable is connected to the hard disk socket so that the marked thread 
is the closest to the power cable, i.e. the marked thread connected to pin #1 of 
the socket. A similar rule was used for connecting cables with the motherboard. 

Incorrect connection of the cable with either the hard disk or the motherboard does 
not necessarily damage the electronics of the disk or the motherboard. The hard 
disk is simply not detected or initialized by BIOS.  

 

There are some models of hard disks, especially the older ones, for which incorrect 
connection damaged the electronics of the drive.  

 

We will not describe all the types of hard disks. Currently the most widespread are those 
with IDE or SCSI interfaces. Unlike IDE hard disks, there can be from six to 14 SCSI hard 
disks installed in your PC. However, you need a special SCSI controller (called a host 
adapter) to connect them. SCSI hard disks are not usually used in personal computers 
(workstations), but are found mostly in servers. 

Aside from an IDE cable, a four-thread power cable must be connected to the hard 
disks. There is only one way to plug in this cable. 

B.1.3 Installation modes, jumpers 
A hard disk can be installed in a computer as master or as slave. The mode of hard 
disk installation is defined by the position of special connectors (called jumpers) on 
the hard disk. 

The jumpers are either located on the electronic board of the hard disk or a special 
socket that provides for the connection of the hard disk and the motherboard. 

There is usually a sticker on the drive that explains the markings. Typical markings 
are DS, SP, CS and PK. 

Each jumper position corresponds to one hard disk(s) installation mode: 

• DS – master/factory default 
• SP – slave (or no jumper required) 
• CS – cable select for master/slave: the purpose of the hard disk is determined by 

its physical position with respect to the motherboard 
• PK – jumper parking position: the position where one can put the jumper if it is 

not necessary in the existing configuration 
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The hard disk with the jumper in master position is treated by the basic input/output 
system (BIOS) as bootable. 

The jumpers on hard disks that are connected to the same cable can be in the cable 
select for master/slave position. In this case, BIOS will deem as «master» the disk 
that is connected to the IDE cable closer to the motherboard than the other one. 

 

Unfortunately, hard disk markings were never standardized. You might well find that 
markings on your hard disk differ from the ones described above. Moreover, for the old 
types of hard disks, their purpose could be defined by two jumpers instead of one. You 
should study the markings carefully before installing your hard disk in the computer. 

It is not enough to physically connect the hard disk to the motherboard and set the 
jumpers properly for the hard disk to function — hard disks have to be properly 
configured with the motherboard BIOS. 

B.2 BIOS 

When you turn on your computer, you often see a number of short text messages 
before you see the splash screen of your operating system. These messages are 
from the POST (power-on self test) program that belongs to BIOS and is executed 
by the processor. 

BIOS, or the basic input/output system, is a program that resides in the permanent 
memory chip (ROM or flash BIOS) on the motherboard of your computer and is its 
key element. The version of BIOS that you use «knows» all the peculiarities of all 
the components of the motherboard: processor, memory, integrated devices. BIOS 
versions are provided by the manufacturers of motherboards. 

Main BIOS functions are: 

• POST checking of processor, memory and I/O devices 
• initial configuring of all software-manageable parts of the motherboard 
• initialization of operating system (OS) booting process 

Among numerous components of the computer, initial configuration is necessary for 
the external memory subsystem that controls hard disk drives, floppy disk drives, 
CD-ROM drives, DVDs and other devices. 

B.2.1 Setup utility 
BIOS has a built-in setup utility for initial computer configuration. To enter it, you 
have to press a certain combination of keys (Del, F1, Ctrl+Alt+Esc, Ctrl+Esc, or 
some other, depending on your BIOS) during the POST sequence that starts right 
after you turn your computer on. Usually the message with the required 
combination of keys is displayed during the startup testing. Pressing this 
combination takes you to the menu of the setup utility that is included in your BIOS. 

The menu can differ in appearance and sets of items and their names, depending 
on the BIOS manufacturer. The most widely known BIOS makers for PC 
motherboards are Award/Phoenix and AMI. Moreover, while items in the standard 
setup menu are mostly the same for various BIOSes, items of the extended setup 
heavily depend on computer and BIOS version. 

Below we describe the general principles of initial hard disk configuration, and then 
configuration (sample) in AwardBIOS. 
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Large PC manufacturers like Dell and Hewlett-Packard produce motherboards themselves, 
and develop their own BIOS versions. You should always refer to the documentation that 
came with your computer for instructions on proper BIOS configuration. 

B.2.2 Standard CMOS setup menu 
Parameters in the standard CMOS setup menu usually define the geometry of the 
hard disk. The following parameters (and values) are available for each hard disk 
installed in your PC: 

Parameter Value Purpose 

Type 1-47, Not 
Installed, 
Auto 

Type 0 or Not Installed is used when there is no 
hard disk installed (to uninstall it). Type 47 is 
reserved for user-defined parameters or for 
parameters detected by the IDE Auto detection 
utility. 

Auto value allows for automatic detection of IDE 
disk parameters during the boot sequence. 

Cylinder (Cyl) 1-65535 The number of cylinders on a hard disk. For IDE 
disks, a logical number of cylinders is specified. 

Heads (Hd) 1-16 The number of heads on a hard disk. For IDE 
disks, a logical number of heads is specified. 

Sectors (Sec) 1-63 The number of sectors per track of a hard disk. For 
IDE disks, a logical number of sectors is specified. 

Size (Capacity) MBytes The capacity of the disk in megabytes. It is 
calculated according to the following formula: 

Size=(Cyl x Hds x Sct x 512) / 1024 / 1024. 

Mode 
(Translation 
Method) 

Normal/ 
LBA/ 
Large/Auto 

Method of translation of sector addresses. 

For example, to demonstrate the main features of SonicWALL Bare Metal Recovery 
and Local Archiving – Workstation, we used a QuantumTM FireballTM TM1700A hard 
disk as one of the disks in our examples. Its parameters have the following values: 

Parameter Value 

Type Auto 

Cylinder (Cyl) 827 

Heads (Hd) 64 

Sectors (Sec) 63 

Mode Auto 

CHS 1707 MB 

Maximum LBA Capacity 1707 MB 

In BIOS setup, you can set the Type parameter to User Type HDD (user-defined 
type). In this case, you also have to specify the value of the translation mode 
parameter, which can be Auto/Normal/LBA/Large. 



 

Copyright © Acronis, Inc., 2000-2008                                                                                        51 

 

Translation mode is how sector addresses are translated. This parameter appeared because 
in BIOS versions, there were limitations to the maximum address capacity of disks, which is 
504 MB (1024 cylinders x 16 heads x 63 sectors x 512 bytes). There are two ways to 
bypass this limitation: (1) switch from physical to logical sector addresses (LBA), (2) use 
mathematics to reduce the number of addressed sectors (cylinders) and increase the 
number of heads; this method is called Large Disk (Large). The simplest decision is to set 
the value of this parameter to Auto. 

If there are several hard disks connected to your motherboard, but you do not want 
to use some of them at the moment, you have to set the Type of these disks to Not 
Installed. 

Parameters of hard disks can be set manually with the help of information provided 
by the hard disk manufacturer on its case, but it is easier to use the IDE 
autodetection utility that is usually included in modern BIOS versions. 

The utility is sometimes a separate BIOS menu item and sometimes is included in 
the standard CMOS setup menu. 

 

Please note that in 0, «Appendix B.  Hard disks and BIOS setup», we have described the 
general details of physical hard disk structure. Built-in IDE hard disk controls mask the 
physical disk structure. As a result, the BIOS of the motherboard «sees» logical cylinders, 
heads and sectors. We are not going to elaborate on this issue here, but knowing about this 
can sometimes be useful. 

B.2.3 Arranging boot sequence, advanced CMOS setup menu 
Aside from standard CMOS setup, BIOS menu usually has an advanced CMOS setup 
item. Here you can adjust the boot sequence: C:; A:; CD-ROM:. 

 

Please note that boot sequence management differs for various BIOS versions, e.g. for 
AMI BIOS, AWARDBIOS and brand-name hardware manufacturers.  

Several years ago, the operating system boot sequence was hard-coded into the 
BIOS. An operating system could be booted either from a diskette (drive A:), or 
from the hard disk C:. That was the sequence in which the BIOS queried external 
drives: if drive A: was ready, BIOS attempted to boot an operating system from a 
diskette. If the drive was not ready or there was no system area on diskette, BIOS 
tried to boot an operating system from hard disk C:.  

At present, BIOS allows booting operating systems not only from diskettes or hard 
disks, but also from CD-ROMs, DVDs and other devices. If there are several hard 
disks installed in your computer labeled as C:, D:, E:, and F:, you can adjust the 
boot sequence so that an operating system is booted from, for example, disk E:. In 
this case, you have to set the boot sequence to look like E:, CD-ROM:, A:, C:, D:. 

 

This does not mean that booting is done from the first disk in this list; it only means that 
the first attempt to boot an operating system is to boot it from this disk. There may be no 
operating system on disk E:, or it can be inactive. In this case, BIOS queries the next drive 
in the list. Errors can happen during booting, see B.2.5 «Hard disk initialization errors». 

The BIOS numbers disks according to the order in which they are connected to IDE 
controllers (primary master, primary slave, secondary master, secondary slave); 
next go the SCSI hard disks. 

This order is broken if you change the boot sequence in BIOS setup. If, for 
example, you specify that booting has to be done from hard disk E:, numbering 
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starts with the hard disk that would be the third in usual circumstances (it is usually 
the secondary master). 

After you have installed the hard disk in your computer and have configured it in 
BIOS, one can say that the PC (or the motherboard) «knows» about its existence 
and its main parameters. However, it is still not enough for an operating system to 
work with the hard disk. 

B.2.4 AwardBIOS 

Below, we provide an example of configuring hard disks in AwardBIOS. 

The Main AwardBIOS menu, which is responsible for configuring hard disks on 
motherboards for Celeron, Pentium II-III and AMD-K6/K7 processors usually looks 
like this: 

AwardBIOS Setup Utility 
Main Advanced Power Boot Exit  

System Time [16:16:35] Item Specific Help: 
System Date [01/10/2001]  
Legacy Diskette A [1.44M, 3.5in] <Enter> to go to sub- 
Legacy Diskette B [None] menu. 
Floppy 3 Mode Support [Disabled]  
   
Primary Master [Auto]  
Primary Slave [Auto]  
Secondary Master [Auto]  
Secondary Slave [Auto]  
   
Language [English]  
Supervisor Password [Disabled]  
User Password [Disabled]  
Halt On [All but Disk/Keyboard]  
Installed Memory [Disabled]  
   
   
F1 Help ↓ Select Item -/+ Change Values F5 Setup Defaults 
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit 

Place the marker on the Primary Master line and press the Enter key to get to the 
screen that looks like this: 

AwardBIOS Setup Utility 
Main      

Primary Master [Auto]  Item Specific Help: 
   
Type [Auto] <Enter> to select the type 
  of the IDE drive. 
   
  [User Type HDD] allows 
  you to set each entry on 
  your own. 
   
  Warning: Ultra DMA Mode 
  3/4/5 can be enabled only 
  when BIOS detects  
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  Shielded 80-pin cable. 
   
   
F1 Help ↓ Select Item -/+ Change Values F5 Setup Defaults 
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit 

Place the marker on the value of the Type parameter ([Auto] in this case) and press 
the Enter key to open the list of possible values of this parameter; for example: 

None 
Auto 
User Type HDD 
CD-ROM 
LS-120 
ZIP-100 
MO 
Other ATAPI Device 

Use the Up and Down keys to select the User Type HDD value and press the Enter 
key to get to the following screen: 

AwardBIOS Setup Utility 
Main      

Primary Master [User Type HDD]  Item Specific Help: 
   
Type [User Type HDD] <Enter> to select the type 
Translation Mode [LBA] of the IDE drive. 
   
Cylinders [………0] [User Type HDD] allows 
Head [……0] you to set each entry on 
Sector […0] your own. 
CHS Capacity  0MB  
Maximum LBA Capacity 0MB Warning: Ultra DMA Mode 
  3/4/5 can be enabled only 
Multi Sector Transfer  [Maximum] when BIOS detects  
SMART Monitoring [Disabled] Shielded 80-pin cable. 
PIO Mode [4]  
Ultra DMA Mode [5]  
   
F1 Help ↓ Select Item -/+ Change Values F5 Setup Defaults 
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit 

Enter the values of Translation Mode, Cylinders, Head and Sector parameters (you 
can find them on the case of the hard disk) to finish the initial configuration of the 
hard disk with BIOS. 

Translation Mode parameter can have the following values: 

LBA 
Large 
Normal 
Match Partition Table 
Manual 

New versions of AwardBIOS menu have the Boot item. The screen of the Boot 
menu, which is responsible for adjusting the boot sequence, looks like this: 

AwardBIOS Setup Utility 
Main Advanced Power Boot Exit  

1. ATAPI CD-ROM [None] Boot Sequence: 
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2. Removable Device [Legacy Floppy]  
3. IDE Hard Drive [IBM-DTLA-307020] <Enter> to select the de- 
4. Other Boot Drive [Disabled] vice To select the boot se- 
  quence, use up or down Ar- 
Plug & Play O/S [No] row. 
Boot Virus Detection [Enabled]  
Quick Power On Self Test [Enabled] Press <+> to move the 
Boot up Floppy Seek [Enabled] Device up the list, or 
Full Screen Logo [Enabled] <-> to move it down 
  the list 
   
   
   
   
   
   
   
F1 Help ↓ Select Item -/+ Change Values F5 Setup Defaults 
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit 

Place the marker on the field to the right of the 3. IDE Hard Drive item and press 
the Enter key to open the list of all hard disks connected to your computer and 
detected by BIOS, together with the Disabled line; for example: 

Disabled 
Quantum FireBALL_1700A 
IBM DTLA-307020 
Quantum FireBALL_1700A 

This device sequence in the upper left corner of the screen means that when 
looking for a boot disk, the BIOS will first query the CD-ROM (1. ATAPI CD-ROM), 
but there is no CD-ROM in the current configuration. Next it queries the floppy disk 
drive (2. Removable Device). Only if none of these disks contains an operating 
system, does BIOS query the hard disk (3. IDE Hard Drive) that has been selected 
from the list. 

Select an item of the list with the Up or Down keys and move the device up the list 
or down it with help of + or - keys. This will change the boot sequence. For 
example, you can select the boot sequence as the one shown below: 

AwardBIOS Setup Utility 
Main Advanced Power Boot Exit  

1. Removable Device [Legacy Floppy] Boot Sequence: 
2. ATAPI CD-ROM [None]  
3. IDE Hard Drive [IBM-DTLA-307020] <Enter> to select the de- 
4. Other Boot Drive [Disabled] vice To select the boot se- 
  quence, use up or down Ar- 
Plug & Play O/S [No] row. 
Boot Virus Detection [Enabled]  
Quick Power On Self Test [Enabled] Press <+> to move the 
Boot up Floppy Seek [Enabled] Device up the list, or 
Full Screen Logo [Enabled] <-> to move it down 
  the list 
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F1 Help ↓ Select Item -/+ Change Values F5 Setup Defaults 
Esc Exit ←→ Select Menu Enter Select Sub-Menu F10 Save and Exit 

After setting the specified parameters, use the Left or Right keys to select the Exit 
menu item. Reply positively to the prompt on saving the specified parameters. 

For AwardBIOS for motherboards for Pentium, Pentium Pro processors (i.e the ones 
older than those described above) and AMD-K5/K6, the standard CMOS setup 
screen looks like this: 

ROM PCI/ISA BIOS (2A69JA2A) 
STANDARD CMOS SETUP 
AWARD SOFTWARE, INC. 

          
Date (mm:dd:yy) : Fri, May 15 1998     
Time (hh:mm:ss) : 11: 33: 53      
          
HARD DISKS    : TYPE SIZE CYLS HEAD PRECOMP LANDZ SECTOR MODE 
Primary Master : Auto 0 0 0 0 0 0 Auto
Primary Slave : Auto 0 0 0 0 0 0 Auto
Secondary Master : None 0 0 0 0 0 0 0
Secondary Slave : None 0 0 0 0 0 0 0
          
Drive A : 1.44 M          

Drive B : None         Base Memory: 0K  
      Extended Memory: 0K  
Video : EGA/VG      Other Memory: 512K  

Halt On: All Errors      Total Memory: 512K  
          

ESC : Quit   ↓→←: Select Item    PU/PD/+/- : Modify 
F1 : Help   (Shift) F2 Change Color   

The Type parameter can have Auto, Not Installed or User Defined values. In the 
latter case, you have to specify the values of other parameters manually (except 
MODE) according to the information on the case of the hard disk. 

 

The purpose of the MODE and LANDZ parameters is described in the note above. The 
PRECOMP parameter is the so-called precompensation parameter and is important only for 
the older hard disks (MFM and RLL). IDE disks ignore this parameter.  

In earlier BIOS versions, the boot sequence was set in the BIOS FEATURES setup 
section in the Boot Sequence line where you could select the most typical boot 
sequences, for example C:; A:;CD-ROM: or CD-ROM:; C:; A:, and other. 

B.2.5 Hard disk initialization errors 
Devices are usually initialized successfully, but sometimes errors can happen. 
Typical errors related to hard disks are reported by the following messages: 

PRESS A KEY TO REBOOT 

This error message is not directly related to errors during hard disk initialization. 
However, it appears, for example, when the boot program finds no operating 
system on the hard disk, or when the primary partition of the hard disk is not set as 
active. 

DISK BOOT FAILURE, 
INSERT SYSTEM DISK AND  
PRESS ENTER 
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This message appears when the boot program finds no available boot device, be 
that a floppy or a hard disk, or a CD-ROM. 

C: DRIVE ERROR 
C: DRIVE FAILURE 
ERROR ENCOUNTERED  
INITIALIZATION HARD DRIVE 

This message appears when it is not possible to access the C: disk. If the disk is 
known to be functional, the reason for this error message is probably incorrect 
settings/connections of: 

• hard disk parameters in BIOS setup 
• jumpers on the controller (master/slave) 
• interface cables 

It is also possible that the device is out of order, or the hard disk is not formatted. 

 


